
Umbilical Logging Systems 

· Wireless logging system 

· Measure pressure and resistance 

· Pressure ranges up to 1000 bar 

· Resistance ranges up to 2000 ohms 

· Rugged weatherproof case 

· Additional sensors available 

· Export data to Excel, Word etc. 

· Real time PC graph display 

Specification - RX250AL Data Logger / Receiver 

Inputs Pressure and resistance 

Channels Minimum 4 expandable up to 250 

Memory Capacity 247,000 readings  

Logging Modes Single point or average 

Logging Rate Programmable - 10 seconds to 12 hours 

Data Retention Over 200 years with no power 

Operating Range -40 to +60 degrees C 

Power Supply Mains plug pack with 24 hour battery backup  

Data Format Graphic and CSV, suitable for export to Excel 

Display LCD provides real time readings independent 
of PC. 
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GS44 Transmitter Units 

Specification - GS44 Transmitter Units 

Inputs 0-5v ( from pressure sensors ) or resistance 

Channels 4 per transmitter, max 250 per system 

Range 2 KM line of site or 200 metres in buildings 

Battery Life Up to  3 months on a 30 sec transmit cycle 

Typical umbilical drum. The 
GS44 transmitter units are 

situated the top of the drum in a 
weatherproof housing 

RX250AL Logger/Receiver 
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Darca Plus software provides powerful but simple-to-use tools for configuring and metering the umbilical logger channels, 
and changing logger settings, downloading data and analysing it either graphically or statistically. When the logger / receiver 
unit is connected to a PC via the serial port real time data can be viewed in graph or mimic panel format. 

 
Key Features 
 
¨ All operational control of the logger may be performed using the PC  

¨ Data can be exported into text format for analysis in a spreadsheet   

package 

¨ Intelligent storage of logger configuration provides fast connection to  the 

logger 

¨ Logger channels may be scaled into appropriate engineering units 

¨ Copy and Paste tools in Channel Setup for simple and fast channel    

configuration 

¨ Alarm feature warns if any channel inputs are outside ‘safe’ limits 

¨ Logger configuration may be saved as a Setup File and then applied            

to other loggers 

¨ User-friendly interface for highly intuitive operation 

¨ Multiple windows may be displayed simultaneously to provide total     

control over Channel Setup and Metering 

¨ Displays all selected channels on screen simultaneously 

¨ Contact Wizard guides you through the stages of contacting the  logger 

¨ ’Shed’ utility allows scheduled, automated downloading of data from the 

logger 

¨ Comprehensive help for first time or experienced users 

 
 
Darca Plus Features 
¨ Windows 95/98/ME/2000/NT4/XP         compatible 

¨ Baud rate selectable between 1200 and 34800 baud 

¨ Password protection for tamper-proof  operation 

¨ Configurable refresh times of Meter Window and Squirrel status 

¨ Memory Size Calculator optimises download time 

¨ Connection to Squirrel via Serial Port or USB 

¨ Printer output 

¨ Modem connection to Squirrel via GSM or land line 

¨ Powerful graphing tools display  real-time or historical data  - 3D plots, 
line, and event and. 

¨ Plot colour and axis configuration can be saved  - Text comments can 
be added to  points of interest 

¨ Summary window displays data and statistical information 
 

Real Time Metering 
¨ View metered channels as Vertical Bar, Horizontal 

Bar or Needle 

¨ Intelligent resizing 

¨ Channels in alarm are displayed in red 

¨ Grouping of channels 
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Specification - Pi605 Pressure Sensors 
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Characteristics Pi605R Units 

Pressure Ranges:  -1, -1 - +1, 2 , 5 , 6 , 10 , 16 , 
20 , 40 , 60 , 100 , 150 , 200 , 
300 , 400 , 500 , 600 , 700  

Bar gauge 

Rated Output 0.5-4.5V   

Excitation Voltage 5V(regulated  VDC 

Input Current <3  mA 

Output Config 3 wire  No. of wires 

Accuracy 0.25 (<0.10 or <0.05  optional ) +/- % of rated O/P 

Zero balance <0.1  +/- % of rated O/P 

Safe Overpressure 150 Of Range 

Temperature range Compensated +20 to +80  °C 

 Operating -20 to +100  °C 

Temperature Effect On Span <0.010  +/- of  Output/°C 

 On Zero <0.040(<0.020 
Or<0.010 optional)  

+/- of  Rated O/P/°C 

Stability <0.1 over 12 months  +/- of  Rated Output 

Input Resistance 1100 ohms 

Output Resistance 1100 n/a  ohms 

Insulation  >500  Meg ohms at 50vDC 

Media  
Compatability 

Any media  Compatible with 
316 L St St, Alumina &  Seal of 
choice 

 

Weight 100  Grams 

Protection  I.P. 67 with M12 connector  

Specification - Resistance Measurement 

Ranges 0-100, 0-250, 0-500, 0-1000, 0-2000 ohms 

Resolution 1 ohm 

Accuracy +/- 2 ohms up 500 ohms, +/-5 ohms > 1000 ohms 

Other Inputs / Sensors 
The system can be expanded to accept inputs from a wide range of 
compatible sensors, such as temperature, position, angle, load, etc.  
Contact Omni Instruments for further details. 

Weatherproof housing for GS44 Transmitter units. 
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System Diagram 

RX250AL 

GS 
44R 

Resistance Inputs 

Radio link to RX250AL Logger/Receiver 

GS 
44 

Pressure Inputs 

Rx250AL Logger Receiver Unit 
Receives resistance and pressure sig-
nals from the remote transmitter units 
fitted on the carousel. The RX250AL 
stores the readings in solid state mem-
ory, provides a real time LCD display of 
readings, and sends the data real time 
via RS232 serial link to a PC 

Utilising DARCA Plus software the 
RX250AL logger/receiver unit sends the 
pressure and resistance measurements real 
time to a PC, which displays the data in 
graph and mimic panel format. 
 
Historical data from the logger can also be 
downloaded and viewed in graph format, 
and exported to MS Excel for further 
analysis. 
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System Description 

The Omni Instruments Umbilical Logging System is built around the GENII radio data logger system. The main 
components comprise of the RX250AL Logger/Receiver Unit, and GS44 remote transmitters. The system oper-
ates on the 434 MGHz licence free radio band. Range from the transmitters to the receiver unit is 2-3 kilometres 
line of sight or 200 metres in buildings. 
 
Measurement Technique  
In umbilical logging systems both pressure and resistance may be measured. For pressure the GS-44 series 
transmitter unit is used, housed in an ABS plastic IP67 weatherproof enclosure, with external connectors for 
pressure sensors. The pressure sensors are powered by a 5 volt supply from the transmitter. The transmitter is 
powered by 4 x AA 1.5 V alkaline batteries. These are user replaceable. 
 
For resistance measurement the GS-44-R type transmitter is used, again housed in an IP67 weatherproof enclo-
sure with external connectors for the resistance inputs. 
 
The transmitters are pre-programmed to send the measured levels of pressure and temperature every few sec-
onds ( usually around 30 ) to the receiver unit. This update rate can be changed by the user. The RX250AL log-
ger/receiver unit logs the reading to internal memory ( 260K readings ) and also provides a real time LCD display 
and real time PC display via RS232 serial link. The software used for the PC display is DARCA PLUS, which is 
also used to programme the logger and transmitter units. 

System Operation 

Omni umbilical logging systems are supplied pre-configured and ready to run. 
 
Before using the system check that the transmitter units have fresh batteries. These are replaced by removing 
the top cover from the weatherproof housing, releasing the transmitter from the clamp fitting, and removing the 
four small screws at the base of the transmitter. The battery holder slides out and can be detached from the con-
necting wires via the snap on connector. 
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System Operation - Hardware 

Omni umbilical logging systems are supplied pre-configured and ready to run. 
 
Before using the system check that the transmitter units have fresh batteries. These are replaced by removing 
the top cover from the weatherproof housing, releasing the transmitter from the clamp fitting, and removing the 
four small screws at the base of the transmitter. The battery holder slides out and can be detached from the con-
necting wires via the snap on connector. When the GS-44 or GS-44-R units are transmitting the red LED on the 
top will flash periodically. 
 
RX250AL Functions 
 
Start Logging 
 
To start the unit logging press the function button on the front panel of the 
RX250AL logger until the display reads: 
LOG off 
Press the set button and hold. The display will read: 
HOLD TO START 
Continue to hold the button until the display reads: 
LOG on 
Pressing the select button will show the used and free memory 
 
Other Functions 
 
Using the logger keypad a variety of menus can be accessed to display: 
 
METER: Shows real time values - press the select key to scroll through the channels 
 
REVIEW: enables you to scroll through historical data 
 
TIME: displays the logger clock date and time 
 
START: displays the logger start time 
 
INT: shows the logging interval 
 
OUTPUT: the unit should be left set to this for communication to a PC 
 
MODE: shows the logging mode - this should normally be set to: interval 
 
CHANNEL SETUP: displays the number of channels used 
 
STAT: shows the internal battery voltage and external power 
 
Although many functions can be accessed through the logger keypad, the unit can also be setup and controlled 
via a PC using the DARCA PLUS software package. 
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System Operation - Software 

DARCA PLUS - basic functions 
 

 
 
 

Export Data 
Exports saved data 
files to txt and XLS 
format 

Graph Data 
Displays historical 
data in graph format 

Preferences 
Sets meter mode 
Export file settings 
Communications  
timing 

Contact Wizard 
Sets up serial       
communications 

Contacting the logger 
Make sure the logger display is set 
to: OUTPUT 
Follow the setup wizard to select 
the correct com port. Once com-
munication with the logger is es-
tablished this status screen will 
appear showing the logging state, 
interval, start time, memory status, 
power status. 

Download data from the 
logger 

View real time readings 
in graph and meter mode 

Set the logging interval, 
sample interval, date & 
time, logging mode. 

Setup the individual 
channels, input range, 
channel labels, channel 
scaling, alarm levels, 
alarm outputs. 

Start and stop the logger Clear the data from the 
logger 
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System Operation - Software 

DARCA PLUS - setting the logging rate 
 
 
 
 

In meter mode the real time readings from 
the remote transmitters are displayed as 
bar graphs. If an individual channel is in a 
high or low alarm condition the top part of 
the bar will turn red. 

In meter mode real time readings can also 
be displayed in chart format.  

Meter mode settings are en-
tered in the Metering tab of the 
Settings > Preferences menu 
found in the main menu 

Log rate and sample interval are set 
from the Squirrel Settings menu 

DARCA PLUS - meter mode 
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System Operation - Software 

DARCA PLUS - saving, exporting and viewing data 
 
 
 
 

To download historical data from the logger click 
the Download Runs button. You will be prompted 
to enter a file name 

To view downloaded data in graph format click on 
File > View Graph and select the previously 
saved data file.  

To export data to MS Excel click on File > Export. 
Select the data file and click Open. The file will be 
exported as a text file and saved in the Darca 
Data > Export directory 

A summary of the data includ-
ing a full table view of all read-
ings can be accessed from 
the Summary button at the top 
of the chart view 


